
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Agenda 
Windows Basics, Word, PowerPoint, and Excel 
 
 
8:00-8:10------ Introduction, goal setting 
8:10-8 :20-----Saving Grace, or, Where did that file go? 
8:20- 8:30-----Getting the “Word” Out :  Planning a Classroom Poster 
8:30 -10:00 ---Word Basics – Formatting, Page Setup, Drawing Objects, Spell   
                        Check (The Sampler) 
10:00-10:15 --Break 
10:15-11:00  - A Picture is Worth a Thousand Words - Graphics 
11:00-11:45---Tabs 
11:45 -12:00--Fixing those annoying things that Word does 
 
12:00 -1:00 ---Lunch 
1:00 -2:00 ----PowerPoint Basics:  Project:  Welcome Back PowerPoint 
                         Inserting New Slides, Pictures, Movies, Hyperlinks 
                           Changing the layout and background 
                           Adding Transitions 
2:00-2:15------Break 
2:15 -3:00-----Adding Sounds, Options for Saving, Options for Custom Shows, and 
3:00 – 3:30----Strutting your Stuff 
 
 
8:00-  8:30 ----Excel – and what it can do for you  (classroom ideas) 
8:30 – 9:30 ---Dressing up a worksheet—margins, borders, cell merge 
9:30 – 10:00 --Formulas and Sorting 
10:00-10:15---Break 
10:15-11:00 –  Building a class list to sort 
11:00-11:30  -Chart Wizard 
11:30-12:00 -   Evaluation and Reflection 



 
 

STUDY GUIDE 
EDUC 611 PROFICIENCY EXAMINATION 
KERSHAW COUNTY SCHOOL DISTRICT 

 
 
The teaching professional who demonstrates competency in the Windows operating 
system will be able to… 
 

1. create and name folders and sub-folders on any drive specified 
2. save files appropriately within folders and sub-folders on any drive specified 
3. move files between folders and sub-folders on any drive specified 

 
The teaching professional who demonstrates competency in Microsoft Word will be 
able to…. 
 

1. format a document including top, bottom, left and right margins, set tabs for 
paragraph indentions, set paragraph line spacing, page orientation and columns of 
text as specified 

2. insert and format clip art and Word Art into text 
3. insert a table consisting of multiple columns and rows of information as specified 
4. format text including all capitals, font style, font size, bold, italics, and underline 

to entire documents or selected portions of text as specified 
5. align text left, center, right and/or justified as specified 
6. utilize spelling and grammar checker features 
7. preview and print a document 
8. save a document to any drive specified 

 
The teaching professional who demonstrates competency in Microsoft PowerPoint 
will be able to… 
 

1. create a slide show presentation consisting of a title slide and content slides as 
specified 

2. incorporate a variety of slide layout designs within the presentation 
3. insert and format clip art and Word Art into the presentation 
4. select and/or change color of text and/or Word Art 
5. select and apply a background design template to one or all slides 
6. insert transitions between slides 
7. apply custom animation and sound effect to a graphic on a slide 

 
The teaching professional who demonstrates competency in Microsoft Excel will be 
able to… 
 

1. create and format a worksheet including top, bottom, left and right margins, and 
page orientation 



2. size cell width and row height to specified and/or desired size 
3. format all or only selected cells for type of data (number) contained in the cell as 

well as text alignment and wrapping text within a cell as specified 
4. alphabetize data in a worksheet 
5. merge cells to create column headings over multiple columns of data 
6. create and insert a chart of specified type into a worksheet 
7. utilize formulas and functions to manipulate data in cells as specified 
8. set and/or clear print areas, preview, and print worksheet 
9. save worksheet file to any drive specified 

 
The teaching professional who demonstrates competency in utilizing the 
Internet/World Wide Web will be able to… 
 

1. use effectively a web browser to access Internet/World Wide Web resources 
2. use search engines and/or search directories to locate appropriate information 

applicable in public school classroom instruction and/or for teacher reference or 
utility purposes 

3. locate, review, and select appropriate online activities for public school classroom 
instruction 

4. locate, review, and select age-appropriate, credible web sites for student use in 
public school classroom instruction and/or at home activities 

5. download text and images from Internet/World Wide Web resources within 
copyright restrictions and save downloaded files to any drive specified 

6. communicate via e-mail, including sending attachments of text and/or graphics 
 



 
 
Saving Grace, or, where did that file go? 
 
 

1. Create and name a folder with your name.  Save it on the specified drive. 
2. Inside this folder, create three folders:  Word, PowerPoint, Excel 
3. Move the folder to a new drive. 
4. Create a Word file with four major goals for your classes this year.  Save it inside 

the “Word” folder. 
5. Add two more goals for your classes. 
6. From the file menu, click “save as.”  Change the name of the file and save it to a 

different location. 
7. Close all windows.  (Red “x”) 
8. Find one document by using “My Computer.” 
9. Right Click on the document and send it to the desktop. 
10. Use “Search” (Start, Search) to find the other document.  Open it. 

 
 

Vocabulary:  Write your definition of the term in the blank: 
File __________________________________________________________________ 
 
Folder_________________________________________________________________ 
 
Drive__________________________________________________________________ 
 
Save ___________________________________________________________________ 
 
Save As_________________________________________________________________ 
 
Send to:_________________________________________________________________ 
 
Right-Click -_____________________________________________________________ 
 
The Short Version of Jim’s Top Ten Tips: 

1. Double Click on My Computer to see all the drives and devices on your system. 
2. The My Pictures and My Music folders have task panes that are customized for 

music and picture files. 
3. You can display your files by lists, icons, tiled, or with details. 
4. The fastest way to copy a file is to right-click the file and select Send To from the 

pop-up menu. 
5. All files you delete are sent to the Recycle Bin folder. Until the Recycle Bin is 

filled up, you can restore any file you've recently deleted. 



See http://www.peachpit.com/articles/article.asp?p=24588&seqNum=5 for more XP 
management tips. 

Great information to keep in mind if you want to find your files again: 

Files are stored on your disk in folders. A folder can contain both files and additional 
folders. (A folder within a folder is called a subfolder.) 

The exact location of a file is called its path and contains all the folders leading to the 
file. For example, a file named filename.doc that exists in the system folder that is 
contained in the windows folder on your c:\ drive has a path that looks like this: 
c:\windows\ system\filename.doc 



 
Pictures in Word 
 
 Ways to get pictures: 
 1.  Clips Online—Insert, Picture, ClipArt. ClipsOnline, follow instructions 
 2.  Print Screen Instructions: 
  To copy the window or screen contents : 
To copy an image of the window that is currently active, press ALT+PRINT SCREEN.  
To copy an image of the entire screen, press PRINT SCREEN.  
Note:  
To paste the image into a document, on the Edit menu in the document window, click 
Paste 
 
 c.  From Disks 
 d.  from a scanner 
Ways to manipulate pictures: 

 On View, choose 
Toolbars, then Picture.  
  

  
1.  TextWrap Button – Choose  and 
click a layout choice to pick up and move your picture. 
2.  Cropping – Choose Crop Button.  Move changed cursor over side, or top, hold down  

mouse button, and drag.) 
      (Note that as you move your mouse over each button, Word tells you what each one 

 does) 
  
 
Drop Caps 
A drop cap is a large letter that begins a paragraph and drops through several lines of text 
as shown below. 
Add a drop cap to a paragraph by following these steps: 
Place the cursor within the paragraph whose first letter will be dropped.  
Select Format|Drop Cap from the menu bar.  
The Drop Cap dialog box allows you to select the position of the drop cap, the font, the 
number of lines to drop, and the distance from the body text.  
Click OK when all selections have been made.  

o modify a drop cap, select Format|Drop Cap again to change the attributes, or 
click on the letter and use the handle. 
 

 

 

T 



More Great Tips to Make Word Work for 
You: 
 
 
 
Do you need to print one page, and you have two pages?   
1. From the file menu, choose print preview. 
2. From the print preview buttons at the top of the dialog box, choose “shrink to fit.” 

Word automatically shrinks your text to fit on one printed page. 
 

 
 
 
Text Boxes let you move text anywhere you want 
 

1. From the draw toolbar,  choose the textbox symbol or from the Insert menu 
choose Text Box. 

2. Position the the TextBox  by dragging; add format features like fill, line color, 
border or no border. 

3. If you don’t want the border to show, right click the textbox; choose Format 
Textbox, then choose “no line” for border. 

 

Even faster:   http://search.officeupdate.microsoft.com/TemplateGallery/ct149.asp  
(Search Google for Microsoft Word Templates)  
 
Click on Edit in Word, then do a save as Template if you will use it again (default 
save is in Template folder), put in your information, then save as regular document. 



 
 
Glitter and Glitz 
 
Word Art instructions: 
 
Click on the WordArt Button on the draw toolbar, or on the View menu select toolbar 
then WordArt. 

 
 

If you choose the toolbar, click the “A”, write your text.  Click on each of the buttons in 
turn to see what happens.  To free rotate, make sure the circular arrow is centered around 
the green circle, click and hold, then move your art.  The WordArt toolbar will appear if 
you click once on any WordArt. 
 
Also, click on the yellow diamond and see what happens. 
 
Callout Objects: 
Callout Objects can be lots of fun.   
Click AutoShapes, then Callouts, then click on the shape you want. 
Click and drag a callout shape. 
To move the speech balloon in the right direction, click and hold the yellow diamond. 
The Callout is a special textbox and allows you to write what you want on the inside. 
 
Format Painter 
 
If you don’t want to take the time to format a section but want it to be the same as 
another, click in the paragraph you want, then click the Format Painter from the top menu 
buttons (paint brush) and drag it over the text you want to change.  Double click the 
Format Painter button to keep it active for more than one selection. 
 
Special Characters 
Need a degree sign?  Or perhaps an umlaut?  Use Insert, Symbols, and find the character.  
If you use it often, assign it a shortcut key or an autocorrect key. 
 

My dog 
has fleas. 



 

Insert a Table 

There are two ways to add a table to the document using the Insert feature: 

 Click the Insert Table button on the standard toolbar. Drag the mouse along the grid, highlighting 
the number of rows and columns for the table.  If the button isn’t there, check the double arrows 
for more buttons. 

 
 Or, select Table|Insert|Table from the menu bar. Select the number of rows and columns for the 

table and click OK. 

 



Draw a Table 

 Draw the table by selecting Table|Draw Table from the menu bar. The cursor is now the image of 
a pencil and the Tables and Borders toolbar has appeared.  Unclick the pencil when finished. 

 
 Draw the cells of the table with the mouse. If you make a mistake, click the Eraser button and 

drag the mouse over the area to be deleted.  

 

Inserting Rows and Columns 
Once the table is drawn, insert additional rows by placing the cursor in the row you want 
to be adjacent to. Select Table|Insert|Rows Above or Rows Below. Or, select an entire 
row and right-click with the mouse. Choose Insert Rows from the shortcut menu. 
 
 
Using Fill, Color, and Merge and Selecting Cells, Rows, or Columns 
 
 
Selecting:   Cursor changes to a white arrow:  Selects contents of one row. 

Cursor changes to a black arrow:  One click selects contests of cell, two 
clicks selects row. 
Move cursor to the top of the column you want to select; changes to black 

arrow pointing  
down; selects contents of column.  
Clicking on the cross arrow once selects contents of the whole table. 

Deleting: To delete a table, use select it, then choose Table Menu, Delete, Table.  
Using the delete  

key deletes the contents but not the table. 
 
Moving: Use the tab to move from cell to cell. “Enter” enlarges the cell.  Use the 
down or up 

arrow to move one cell up or down.   
Filling:  Select the cell, row or column you wish to have filled with color, 
then click the paint 
  Click the paint bucket or pull down the menu to choose a different color. 
 
  Or, right  click the table and use the borders and shading  dialog box for 
more choices. 
  
Text Alignment:   Note that you can use right click for formatting options as well as the 
Tables and  

Borders  for Text Alignment,  sorting, and changing the borders. 
 



Tip:  Use tables to align pictures easily, especially if you want to use the 
document as a Web  

page.  The pictures won’t move all over the page.  To remove the table 
borders, right 

click the table, use the borders and shading button, and on the Borders tab, 
select “none”  

for the border line. 
 

 
 



 

Things that ‘bug’ you in Word: 
 
Autocorrect and auto format   
 Turn it off by using the Tools Menu.  “AutoCorrect”.  The AutoCorrect dialog 
box has four tabs:   

 
Uncheck any boxes to make Word quit typing for you. 

AutoFormat as you Type has the infamous “automatic numbered lists” checkbox. 
 
 
To turn off editing options or Spelling & Grammar options: 
 Choose Tools then Options: 

 
Overtype mode: 
 If the OVR button at the bottom of the status bar is black, you’re in overtype 
mode.  Doubleclick it to return your sanity.  You have probably accidentally hit the 
“insert” key above the “delete” key, which is the keyboard shortcut for Overtype mode. 
 



 
 

Quick Starts      PowerPoint XP 
 
To add a new slide: 
 

1. Insert>New Slide 
2. Click the thumbnail slide (in the left pane) and click ‘Enter” 
3. Control +M (Control + N gives you a whole new presentation) 

 
To use Microsoft’s pre-designed templates: 

1. Format>Slide Design 
2. Click on choice from slide design pane, right side of screen 

 
To change the background color: 

1. Format > Background 
2. Pull down arrow lets you choose many fills 
3. Choose  “Apply to All” to add this background to all slides 
4. Choose  “Apply” to add this background only to the current slide 

 
 
To add a picture: 

1. Insert>picture 
2. Choose “clip art” to find a graphic from Microsoft’s collection 

a. On the right pane, enter a search term; or 
b. Choose “clips online” for lots of choices 

3. Choose “file” to use a picture you have on your computer or have on your camera 
To add a text box: 

1. Insert>text box 
2. Choose horizontal or vertical 
3. Draw the text box  
4. Rotate by grabbing the green circle 
5. Position by clicking and holding the border area and dragging 

 



 
 
 
 
To add animations: 

1. Slide Show>Animation Schemes 
a. This choice lets you apply animations to one or more slides 
b. The right task pane gives you the choices 
c. Use this for quick and easy glitz 
d. You can also use the pull-down window in the right task pane to choose 

this command 
e. Use the Play command to preview 

2. Slide Show> Custom Animation 
a. Use this choice when you want to design your own slide happenings 
b. The right task pane gives you choices and choices and more choices 
c. Note that custom animations apply only to the slide you are working on 
d. You can apply custom animations to text, pictures or any other object 

 
To add slide transitions: 

1. Slide Show>Slide Transitions 
2. The right task pane gives you the choices 
3. Be sure to click “apply” or “apply to all”  

 
To work in outline view 

1. Click the “Outline” tab in the left task pane 
2. Type your outline:  remember not to put too much text on one slide 
3. Decide on a template and apply 
4. Voila!  Your PowerPoint is ready to go. 
5. Be sure to check each slide before you use it; some of the text may move around 

when you change templates. 
 
To add a hyperlink: 

1. Type a web address (http://4oops.com) in a text box.  Touch “enter” to make it 
“hot” 

2. Or, select text or a picture. (Drag across text; click on a picture once.) 
3. Choose Insert>hyperlink 
4. Type the web address in the address box. 



5.  
 
 
Great Internet Links For More PowerPoint POWER 
 

1. ActDen   http://www.actden.com/pp/index.htm     This site is a free, easy-to-use, 
basic tutorial for PowerPoint and other Office Applications  

2. Microsoft Education Powerpoint Lessons 
http://www.microsoft.com/Education/Flowcharts.aspx  This site has many ways 
to use PowerPoint in your classroom 

3. Templates  http://office.microsoft.com/en-
us/templates/CT011323751033.aspxThis site has more templates if you want to 
see others 

4. Backgrounds for Teachers  http://www.brainybetty.com/educators2.htm  or 
http://www.brainybetty.com/educators1.htm  This site lets you download neat 
backgrounds.  (It won’t work in Windows 98 unless you have WinZip) 

5. Also check out Brainy Betty’s homepage:  
http://www.brainybetty.com/MENUEducators.htm since there are lots of other 
useful links here 

6. OOPS’ MS Office links for Terrific Teachers:  
http://www.oops.bizland.com/msofficelinks.htm   Many great PowerPoint links 
when you want a little more pizzazz in your presentation 



 

Excel  Basics  
Microsoft Excel Screen Elements 

 

 

Formulas 

Formulas are entered in the worksheet cell and must begin with an equal sign "=". The 
formula then includes the addresses of the cells whose values will be manipulated with 
appropriate operands placed in between. After the formula is typed into the cell, the 
calculation executes immediately and the formula itself is visible in the formula bar. See 



the example below to view the formula for calculating the sub total for a number of 
textbooks. The formula multiplies the quantity and price of each textbook and adds the 
subtotal for each book. 

Relative, Absolute, and Mixed Referencing 

Calling cells by just their column and row labels (such as "A1") is called relative referencing. When a 
formula contains relative referencing and it is copied from one cell to another, Excel does not create an 
exact copy of the formula. It will change cell addresses relative to the row and column they are moved to. 
For example, if a simple addition formula in cell C1 "=(A1+B1)" is copied to cell C2, the formula would 
change to "=(A2+B2)" to reflect the new row. To prevent this change, cells must be called by absolute 
referencing and this is accomplished by placing dollar signs "$" within the cell addresses in the formula.  

Autofill 

The Autofill feature allows you to quickly fill cells with repetitive or sequential data such 
as chronological dates or numbers, and repeated text. 

 Type the beginning number or date of an incrementing series or the text that will be 
repeated into a cell.  

 Select the handle at the bottom, right corner of the cell with the left mouse button and 
drag it down as many cells as you want to fill.  

 Release the mouse button.  

If you want to autofill a column with cells displaying the same number or date you must 
enter identical data to two adjacent cells in a column. Highlight the two cells and drag the 
handle of the selection with the mouse. 
 

Basic Sorts  

To execute a basic descending or ascending sort based on one column, highlight the cells 
that will be sorted and click the Sort Ascending (A-Z) button or Sort Descending (Z-A) 
button on the standard toolbar. 

Charts allow you to present data entered into the worksheet in a visual format using a 
variety of graph types. Before you can make a chart you must first enter data into a 
worksheet. This page explains how you can create simple charts from the data.  

Chart Wizard  

The Chart Wizard brings you through the process of creating a chart by displaying a 
series of dialog boxes. 



Enter the data into the worksheet and highlight all the cells that will be included in the 
chart including headers. 

 

Chart Type - Choose the Chart type and the Chart subtype if necessary. Click Next. 
Click the Chart Wizard button on the standard toolbar to view the first  

Chart Wizard dialog box.  

Chart Source Data - Select the data range (if different from the area highlighted in step 1) 
and click Next. 

Chart Options - Enter the name of the chart and titles for the X- and Y-axes. Other 
options for the axes, grid lines, legend, data labels, and data table can be changed by 

clicking 
on the 
tabs. Press 
Next to 
move to 
the next 
set of 
options. 



 

Chart Location - Click As new sheet if the chart should be placed on a new, blank 
worksheet or select As object in if the chart should be embedded in an existing sheet and 
select the  worksheet from the drop-down menu. 

 

 

Click Finish to create the chart. 
 

Resizing the Chart 

To resize the chart, click on its border and drag any of the nine black handles to change 
the size. Handles on the corners will resize the chart proportionally while handles along 
the lines will stretch the chart. 

Moving the Chart 

Select the border of the chart, hold down the left mouse button, and drag the chart to a 
new location. Elements within the chart such as the title and labels may also be moved 
within the chart. Click on the element to activate it, and use the mouse to drag the 
element to move it. 

Chart Formatting Toolbar 

 

 

 

 
 
 
 
 


